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Overview

Welcome to Ontrack® PowerControls™, the granular recovery software that saves time, money,
and resources when restoring Microsoft® SQL Server data.

With Onfrack PowerControls, you can:

m Restore tables from native SQL BAK files or offline MDF and LDF in seconds or minutes without
restoring the entire database

® Preview table contents before restoring table
® Restore from backup orstorage fier snapshot directly

Ontrack PowerControls supports SQL 2005 and later and can read MDF, LDF, NDF, and BAK files
from a variety of data sources, such as alocal or shared drive, an external hard drive or even a
storage tier snapshot from a SAN environment.

About the Free Trial

Afterinstallation, Ontrack PowerConftrols operates as a Free Trial by default until a license file is
applied. The Free Trial of Onfrack PowerConftrols is limited in functionality and time-limited to 30
days of use.

With the Free Trial, you can:
= Opensources

= Opentargets

If you would like to have full functionality, or learn more about the purchasing options and product
information for Onfrack PowerControls, visit our website at http://www.ontrack.com.

Data Security

The Ontrack PowerControls user requires:

® Read access fo any SQL 2005 and later offline database files or backup files to be opened as
asource.

® Administrator access fo any SQL Server where the datais to be restored.
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Chapter 1: Looking at the Interface

The Ontrack PowerControls main window is divided into the two Source panes (Source Tree View
and Source List) above the two Target panes (Target Tree View and Target List).

o File Edit View Help
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Source and Target Panes

The Source panes display the contents of the source MDF, NDF, and LDF files, or the first full backup
inthe source BAK file. The Source Tree View displays the selected source database ina
hierarchical view. The Source List displays the columns of the tables selected in the Source Tree
View.

Note: Unsupported columns also appear, but the datain the cells may appear as
<UNSUPPORTED>

The Target panes act as a container for the restored objects on the target server. The Target Tree
View contains the Microsoft SQL Server tables that you copy, drag, or add through the Data
Wizard. The Target List pane displays the columns of the tables selected in the Target Tree View.

When you select a table in either the Source or Target Tree View, the following appearin the
corresponding List:

® Up to the first 1,024 columns (each column displays up to 300 characters).

® Up tothe first 1,000 rows.

Note: A notice appearsin the corresponding List's status bar when the selected table exceeds
these amounts.

Any functions that can be performed on a source or target are available on the menu bar, the
toolbar, or the shortcut menus. For more information, see "Restoring Microsoft SQL Server Tables"

Changing the Appearance of the Main Window

You can change the view in the Ontrack PowerControls window by:

= Viewing or hiding the Toolbar and Status Bar

® Resizing panes separated by a split bar

® Resizing columnsin the Source and Target Lists
m Refreshing the screen

The toolbar and status bar appear by default in the main window, but you can easily hide them.
To hide or view the toolbar or status bar

= Onthe View menu, select or clear Toolbar or Status Bar. A check mark indicates that the bar
is shown.

You can use a split bar (the horizontal or vertical double line that separates two panes) to increase
the area within one pane while simultaneously decreasing the area within the adjacent pane.



To resize panes separated by a split bar

1. Position the pointer over a split bar between the two panes on either the vertical or
horizontal split bar.

File Edit View Help
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Figure 1-1: Resizing panes with the double-headed arrow

2. When the pointer becomes a double-headed arrow, dragit fo resize the pane.

Resizing Columns in the Source and Target Lists
You can change the width of the columns in the Source and Target Lists.

To resize columns
1. Place the pointer between the columns in either the Source or Target Lists.

2. When the pointer becomes a double-headed arrow, drag it fo resize the column width.

Note: You can double-click the double-headed arrow to automatically adjust the column
width.

Refreshing the Screen
You may want torefresh the screen occasionally when you are connected to alive target server,
as the information on the server may update.



To refresh the screen

= Do one of the following:
¢ Onthe View menu, select Refresh.
¢ Pressthe F5key.

Setting Preferences

Use Preferences to set defaults forrecurrent operations, such as running the Data Wizard when you
start the application.

To change preference settings

1. Onthe Edit menu, select Preferences.
2. Select orclearthe following check boxes, as needed:

= Run Data Wizard on startup: If selected, the Data Wizard starts every time you open
Ontrack PowerControls.

= Show warning when no log files specified: If selected, a warning message appears
when opening a file if an LDF file path has not been specified.

= Show referential integrity warning: If selected, a warning message appears when
copying tables with foreign keys.

3. Inthe Temporary File Path box, accept the default location for the .IDX and .DAT files or, if
the files require more hard drive space, specify a new location by clicking Browse |...).
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Chapter 2: Restoring Microsoft SQL
Server Tables

You canrestore a Microsoft SQL Server table by doing the following:

A. Select the source MDF, LDF, and NDF file paths or the source BAK file path.

Important: Verify that the log files and database files were created in the same backup. If your
source database contains an NDF file, it must be included with the MDF file.

1. Openthe Source Path Selection page of the SQL Data Wizard by doing one of the following:

Onthe toolbar, click Open Source 6 .

® Onthe File menu, select Open Source.

= Press Ctrl+S.

= Drag the files to open onto the Source Tree view of the main window.
2. Inthe Source Type drop-down list, select either Files or Folder.

= |fyou selected Files, do one of the following:

e Click Add and use the Open dialog box to browse for the source MDF file, NDF files,
LDF files, or BAK files.
* Open Windows Explorer and drag the source files from their location onto the
Source Files box.
Note: Multiple files can be added to the Source Files box and are listed in the order
they were added; however, only a single database can be opened. Please select
either Microsoft SQL Database files (*.MDF , *.NDF , *.LDF) or Microsoft SQL backup files,
not a combination of both. If you want to remove files from the Source Files box, select
the file and click Remove.

= |fyou selected Folder, do one of the following:
» Enterthe location of the SQL data folder.
» Selectthe path of a previously selected folder.

» Open Windows Explorer and drag the source folder from its location onto the
Source Folder drop-down list

* Click Browse and use the Browse For Folder dialog box to locate the Microsoft SQL
source folder.

3. Click Finish.

Note: When opening Transparent Data Encryption databases, after clicking Finish an "Add
Transparent Data Encryption Database requirements" window appears. Add a path to
Transparent Data Encryption database key and provide Transparent Data Encryption key
password.



B. Connect to the Microsoft SQL Server you are using as the target for your restored data.

1. Openthe Target Server Path Selection page of the SQL Data Wizard by doing one of the
following:

L

" Onthetoolbar, click Open Target = .
= Onthe File menu, select Open Target.
= Press Ctrl+T.
2. Inthe SQL Server Name list, do one of the following:
= Enfer the name of the Microsoft SQL Server you are using as the target.
= Use the drop-down arrow to select a previously used target.

= |fyou do not know exact name of the Microsoft SQL Server, click the drop-down
arrow, then select <Browse for more...>. On the Browse for Servers dialog box, choose
a target scope of either Local Servers or Network Servers, then select the SQL Server
instance you want to connect fo and click OK.
Note: Similar to Microsoft SQL Server Management Studio, the number of instances
listed in the Network Servers tab can vary between queries, for example, when
network load prevents server response. Also, the following are not displayed:

» Hiddeninstances
» Servers notrunning SQL Server Browser service
» Servers with blocked UDP port (1434)

= (Optional) To specify a port number (if selected instance is installed on a port other
than default 1433), type the server name, followed by a comma and the port number
(value from 1 to 65535).

Example: server name\instance name, 1234.
3. Inthe Authentication group, select one of the following:

= Use Windows Authentication to use Windows credentials of the currently logged-in
user to access the web service.

m Use SQL Server Authentication to use Microsoft SQL credentials, then enter the
Username and Password of the user.

4. Inthe Database group, do one of the following:

= Select Connect to Single Database and enter the database you are using as the
target or use the drop-down arrow to select a database on the SQL Server you are
using as the target.

= Select Connect to Server to connect to the SQL Server you are using as the target and
view allits available databasesin the Target Tree View pane.

5. Click Finish.



C. Copy and paste (or drag) a table from a SQL database backup (source) into a live SQL
database (target)

To copy a table from the Source Tree View

1. Inthe Source Tree View, select the table to copy.
2. Do one of the following:

" Clickthe Copyicon Eﬁ] on the toolbar.
= Onthe Edit menu, select Copy.
= Press Ctrl+C (copy).

To paste a table to the Target Tree View

1. Inthe Target Tree View, select a Tables node.
2. Do one of the following:

" Click the Paste icon =%} on the toolbar.

= Onthe Edit menu, click Paste.
= Press Chrl+V (paste).

To drag a table to the Target Tree View

= Drag atable from the Source Tree View into a Tables node in the Target Tree View. Dragging
achieves the same results as copying and pasting.

Using the Data Wizard

The Ontrack PowerConftrols DataWizard guides you through Steps A and B of "Restoring Microsoft
SQL Server Tables".

To open the Data Wizard

= On the File menu, click Use Wizard.

Opening the Source Database from the Command Line

In addition to using the Data Wizard, you can open the source databases with the command line.
To open the source database with the command line

1. Open acommand prompt window.

2. Type thelocation of the Ontfrack PowerControls installation files, followed by PC.SQL.exe.
Enclose both together within double quotes.

3. Append this with the source file(s) and the temporary file path (optional) as parameters.

= Each source file name must be prefixed with the keyword -sourcefile and enclosed
within double quotes. The prefix and the file name must be separated with a space.



= Fach source folder name must be prefixed with the keyword -sourcefolder and
enclosed within double quotes. The prefix and the folder name must be separated

with a space.

= The temporary file path must be prefixed with -t keyword and enclosed within double
quotes. The prefix and the temporary file path name must:

® Be separated with aspace
= Not end with a backslash.

Note: To automatically open the specified source database and view it in the source free

view, type -o.

4. Press Enter.

= |fthe "Show wizard on startup"box is cleared on the Data Wizard, Ontrack
PowerControls opens the Data Wizard at the Source Path Selection page with the

command line content displayed.

Sample Command Result

"C:\[application location]\PC.SQL.exe" -sourcefile
"U\sQL
Database\BAK\2008R2\AdventureWorks2008R2.bak"

Opens the Data Wizard with the source file
AdventureWorks2008R2.bak pre-populated.

"C:\[application location]\PC.SQL.exe" -sourcefile
"U:\SQL
Database\BAK\2008R2\AdventureWorks2008R2.bak"
-t "C:\Users\administrator\AppData\Local\Temp\PC"

Opens the Data Wizard with the source file
AdventureWorks2008R2.bak and temporary
path
C:\Users\administrator\AppData\Local\Temp\PC
pre-populated.

"C:\[application location]\PC.SQL.exe" -sourcefolder
"U:\SQL Database\BAK\2008R2" -t
"C:\Users\administrator\AppData\Local\T emp\PC" —o

Opens the 2008R2 source folder and
automatically displays it in the source tree view.

"C:\[application location]\PC.SQL.exe" -sourcefile
"U:\SQL Database\2008 R2
\AdventureWorks2008R2_Data.mdf" -sourcefile
"U:\SQL Database\2008
R2\AdventureWorks2008R2_log.LDF" -o

Opens the source AdventureWorks2008R2 from
MDF and LDF and automatically displays it in the
source tree view.

"C:\[application location|\PC.SQL.exe -sourcefile
"UA\SQLBACKUPS\Stripe1.bak" -sourcefile
"UA\SQLBACKUPS\Stripe2.bak" -sourcefile

L" U:\SQLBACKUPS\Stripe3.bak” —o

Opens multiple backup files that belong to the
same backup set.

Viewing Copy Progress

Each time you attempft to restore objects to the Target Tree View, Copy Progress displays the

following information:




® Source, Source Path, Target, and Target Path
= Time of the start of the copy operation

= Number of tables to be processed

= Warnings and errors, if any

® Number of rows processed

= Time the copy operation completed

To print Copy Progress Data as a report

® Click Print for areport of the Copy Progress information.

To save Copy Progress Data as a report

= Click Save for a text file of the Copy Progress report.

Exporting Source Tables into CSV Format

In the Source pane, you can export asingle table from an opened MDF, LDF and NDF or BAK file
backupsto a CSVfile.

To export a table from the Source Tree View

1. Inthe Source Tree View, select the table to export.
2. Do one of the following:

Click the Exporticon on the toolbar.

On the Edit menu, select Export.

® PressCtrl+P (export).

= Openthe context menu on asingle table and select Export.
3. Choose the path to save the CSV file with the exported data from the SQL table.
4. Inthe Export Progress window, you can:

= Print Export Progress Data as a report by clicking Print.

= Save Export Progress Data as areport by clicking Save.

= Finish Export by clicking Close.
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Chapter 3: Troubleshooting

If you have issues not addressed in the user guide or the online Help, call our Technical Support
group (1-952-937-2121). Whenreporting anissue, please include any information that might help us
diagnose the problem and have the following:

The version of Ontrack PowerControls you are using (on the Help menu, click About)
The versions of Windows operating systems that you are running

The circumstances and sequence of steps that led to the problem

The text of the error messages (if any appeared).

A list of other Windows-based programs that you were running when the error occurred

11
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